Requirements & Resources

Item needed

1. SCORM 1.2 zip file for each online course, OR
2. URLs for courses available on YouTube, Vimeo or other website

To upload online courses, you’ll need

3. iLearnOregon Administrator Training and permissions

Test site

4. ilearn-testing.oregon.gov

Help docs

Section 1: Getting Started  
About Browsers ........................................................................................................... 5  
Navigation.................................................................................................................... 6  
Learning Home ............................................................................................................. 7  
Publishing Tips ............................................................................................................. 8  
iLearnOregon Roles ...................................................................................................... 9  

Section 2: Course Management  
Types of Online Courses ............................................................................................. 11  
Adding SCORM Courses ............................................................................................. 12  
Adding General Courses ............................................................................................. 20  
Changing Course Availability ...................................................................................... 26  
Who Can Manage & Take Courses? ........................................................................... 28  

Section 3: Managing Enrollment  
Viewing Course Participation ..................................................................................... 31  
Enrolling Users in an Online Course ........................................................................... 34  

Section 4: Appendix  
Naming Conventions .................................................................................................. 36  
Curriculums................................................................................................................ 37  
Versioning................................................................................................................. 38  
Creating Deeplinks to Online Courses ........................................................................ 39  
How to reduce online course size ............................................................................ 42  
Reports ...................................................................................................................... 44  
Uploading Captivate (v7+) Courses to the LMS .......................................................... 44  
Powtoon Videos: How to add..................................................................................... 47
Section 1:

Getting Started

This Section includes

- About Browsers
- Navigation
- Learning Home
- Publishing Tips
- iLearnOregon Roles

For advanced information, look for the Power User icon.
About Browsers

The best browser to use for SCORM courses in iLearn is Firefox. A second good choice is Edge (which replaces IE, starting with Windows 10).

Using IE can cause a Document Mode error message for SCORM courses. If you receive this message, please close IE and use Firefox.
iLearnOregon navigation is at the top of the page.

- The **Main Navigation** (see below) will show for all users.

![Main Navigation Diagram]

- The **Administrative** navigation includes one function that show *only* for Course Administrators: **Responsibilities**. Also, **Custom Tools** shows different functions for administrators than for students.

See the **Responsibilities** section, and the **Custom Tools** section, for navigation information.

**IMPORTANT**

If **Administrative Navigation** does not appear, please see Introduction to Instructor Access in the Appendix.

Also, note that you must complete the iLearnOregon Course Administrator Training before you’ll have access to all the features in this manual.
When you log into your iLearn account, this page appears under the Learning button. This is your main iLearnOregon homepage as a learner.

(1) Home: This screen shows a summary your upcoming courses and transcript, which you can see in detail by selecting the buttons labelled (2) and (3). You can also search the Learning Catalog (5) from this page, or do a detailed search by selecting (4).

(2) Current Training: Shows the upcoming classes you are registered to attend and online courses you’ve started.

(3) Transcript: Shows the status of all courses and curriculums you’ve started, enrolled in and taken, as well as a list of your certifications. You can also print your transcripts, or save them as a PDF, from the Transcript screen.

(4) Catalog: Allows you to search for a course or browse by category.

(5) Search Catalog: A quick search feature for finding courses, curriculums and other content from your Learning Home page.

(6) Custom Tools: Allows you to save your transcript, certifications, billing reports and more in multiple formats. See the section, How to use Custom Tools.

(7) Help: The question mark button leads to more information on how to use iLearn.

(8) Account Information: The dropdown arrow that’s right of your initials leads to your account page. See the section, Update your iLearn Account.
Publishing Tips

In both Captivate and Articulate:

☐ Publish all courses in **SCORM 1.2**.

☐ Publish course reporting status as **Complete/Incomplete**.

☐ When publishing the course, include **HTML5**. If your course contains **Flash** components, publish the course as a **SWF** file, too.

**In Captivate, under Quiz > Reporting:**

☐ At the top, check **Enable reporting for this project** (even if you don’t have a quiz).

☐ If you choose **Slide Views**, do not choose 100% or users won’t be able to finish. At most, choose 90%.

☐ Make sure **Shuffle Answers** and **Allow Backward Movement** are not checked. Both settings cause errors.

**In addition:**

☐ Be sure to test the course in the iLearnOregon Test site: [https://ilearn-testing.oregon.gov](https://ilearn-testing.oregon.gov)

☐ For more on Captivate publishing settings, see the section, **Uploading Captivate Courses in the LMS**.
iLearnOregon Roles

In order to upload and access your eLearning courses, and access student information, you’ll need to be assigned the following roles in iLearnOregon.

- Course Manager
- Training Staff
- Instructor
- Report Manager

In addition, for each course you own, you’ll receive Manage permission. You can add other course managers and specify who will be able to take the course. See the section, Who Can Manage & Take Courses?
Section 2:

Course Management

This Section includes

- Types of Online Courses
- Adding SCORM Courses
- Adding General Courses
- Updating Courses
- Changing Course Availability
- Who Can Manage & Take Courses?

For advanced information, look for the Power User icon.
Types of Online Courses

There are two types of online courses you’ll commonly use in iLearnOregon.

**SCORM**

These courses are the most common in iLearnOregon. SCORM (Shareable Content Object Reference Model) is a set of technical standards that enable eLearning courses and iLearnOregon to communicate with each other. For example, SCORM settings allow iLearnOregon to track course progress and completion, according to criteria specified in a course development program (like Captivate, Articulate or Lectora).

**General Courses**

With General Courses, iLearnOregon will not track course completion (unlike SCORM courses). Instead, when users complete the course, they click a *Mark Complete* button.

General Courses can either be:

- A link to an online course that’s not in iLearnOregon (for example, training from the CDC, FEMA or Microsoft).
- An online course you upload that **does NOT**:
  - Use SCORM.
  - Need to show course progress
  - Need to be automatically marked as complete.

Like SCORM courses, however, General Courses display on transcripts and can be added to curriculums and assigned as training.
Adding SCORM Courses

Before you upload your course:

- If this is a new online course, it’s a good idea to test it in SCORM Cloud to find and fix bugs before you upload it to iLearn Test: [http://scorm.com/scorm-solved/scorm-cloud-features/content-just-works/testing-content-with-scorm-cloud/](http://scorm.com/scorm-solved/scorm-cloud-features/content-just-works/testing-content-with-scorm-cloud/)
- Use a hard-wired internet connection to upload courses, not wireless.
- Copy the zipped file to your desktop and upload from there. You may not be able to upload it from a network drive (although you should always save all course files to a shared drive).
- As a best practice, make sure the zipped file doesn’t exceed 60MB. See the section, How to reduce online course size.

1. After the course works in Test ([https://ilearn-testing.oregon.gov](https://ilearn-testing.oregon.gov)), add it to the “live” Production site: [https://ilearn.oregon.gov](https://ilearn.oregon.gov)

2. In iLearn, click the Responsibilities Tab. Under Manage Content, select Search & Create Content.

3. In Create Courses & Content, select SCORM and Go.

4. In the Create New SCORM Course window, click Browse to search for the zip file you want to upload. When it’s uploaded, click Create.
Adding SCORM Courses

5. On the Edit Summary page, change the title to meet naming convention requirements so it will appear in the proper alphabetical order in search results. See the Naming Conventions information below.

Also add the course description and keywords.

PROTOCOL: NAMING CONVENTION – Course titles should be in the format below, with spaces before and after each hyphen as shown. NOTE: If the course was previously in the Learning Center, add the course number to the title. For example: DHS - CW - Child Welfare Confidentiality - C04155. For more, see Naming Conventions section.

DHS – CW – Child Welfare Confidentiality – C04155

Include a space before and after each hyphen.

6. When you’re finished, click Save.
Adding SCORM Courses

7. To change the course title, description or keywords you just added, click (A) the Edit button to the right of Summary.

8. Click (B) Edit to the right of Course Settings.

9. On the Edit Course Settings page, uncheck Display Page Header and Display Table of Contents.

Check Hide Course Table of Contents When SCO is Accessed and Automatically Open First SCO. Click Save. **NOTE:** If you don’t do this, users will see a blank white window when trying to open the course.

10. Click Edit to the right of Course Information.

11. Add the Course Provider from the dropdown menu. Add the course Duration (in hours or fraction of an hour). **NOTE:** Do not add anything to the Course Number field, since this can cause errors in iLearn. When you’re finished, click Save.
Adding SCORM Courses

12. If the course has **Prerequisites**, click (A) **Edit** to add them.

13. If you’re adding a course that replaces a similar online course, include the outdated course under (B) **Equivalencies > Edit**.

   **NOTE:** Equivalencies are important for curriculums that include previous versions of the online course. See the section, **Curriculums**.

   o Click **Add Equivalencies**.

   o If the previous version is inactive (“hidden”), click **See more search criteria**.

   o Change the **Activity** field to **Inactive** to search for Inactive courses. If the course doesn’t appear, search for Active courses, too.

14. Check courses that are Equivalencies and click **Add**. Click **Back** to return to main course page.
Adding SCORM Courses

15. Back on the main course screen, scroll down to **Content Sharing** and click **Edit**.

16. On the **Manage Content Sharing** screen, make sure the **Shared** boxes are checked next to:
   - Human Services, Department of
   - Oregon Health Authority
   - Other, Non State Employees (if the course needs to be accessed by partners or providers)

   The box will already be checked for your domain (either DHS or OHA), which is called the **Owner Domain**.

17. Scroll to the bottom of the screen and click **Save**.

18. Back on the main course screen, by **Permissions**, click **Edit**.

19. On the **Edit Permissions** screen, click **Assign Permissions**.

20. Fill out the fields as follows:
   - **Search for**: “human services,” “health authority” or “other, non state”.
   - **Search Type**: All words
   - **Type**: Organization
   - **User Search**: All Domains

   Click the **Search** button.
21. Find the organization and check the box in the View column. Click **Save**.
   - Repeat this for all the domains you shared content with.

22. On the **Edit Permissions** page, make sure all the permissions are in place. To do this, change **User Search** to **All Domains** and click **Filter**. This will display a list of all permissions.

When you’re finished, click **Save**, then click **Back** to return to the main course screen.
Adding SCORM Courses

23. If you want to course to be inactive, click (A) **Edit** by **Manage Activity** to make the change.

24. To set the size and attributes of the course window, click (B) **Edit** on the **Window** bar. The window size should be at least the dimensions of your course. (For more, see Uploading Captivate Courses to the LMS.) Set the width and height, and click **Save**. Click **Back** to return to the main course screen.

   **NOTE:** The **Preview** button provides a list of course parameters, not a visual of the course.

25. Do NOT use the (C) **Versioning** feature, which can cause errors. For more information, see the **Versioning** section.

26. Information in the **Credits** section, such as the number of training hours, will appear on student’s transcripts. Add this information as a best practice. By **Credits**, click **Manage**.

27. Click **Add Credit Types**.
Adding SCORM Courses

28. Select the **Credit Type** that applies to your course. If none apply, use **Training Hours**, located at the bottom of the list.

![Credit Type selection]

Add the **course duration** in hours (or fraction of an hour) to the **Credit Value** field so it will appear on user transcripts.

29. Click **Add**, then **Back** to return to the main course screen.

30. When you’re finished, scroll to the top of the main course page. Click the **Check-in** button so students can access your course.

Otherwise, it will be marked as “Temporarily Unavailable” in search results.

31. **Test the course** to be sure it works. Click the **Learning** tab and search for your course in your student view.

32. Make sure the course information appears correctly in search results. Click the title and test the course.
Adding General Courses

General Courses will not be tracked or automatically marked as Complete in iLearnOregon. Typically, these courses are located on another site, like FEMA or CDC. For more, see Types of Online Courses.

33. After the course works in Test (https://ilearn-testing.oregon.gov), add it to the “live” Production site: https://ilearn.oregon.gov

34. In iLearn, click the Responsibilities Tab. Under Manage Content, select Search & Create Content.

35. Search to make sure the course doesn’t already exist. To do this, click See more search criteria.

36. Under Activity, search for Active and Inactive courses. NOTE: These two searches must be done separately. The default blank will not return all results.
Adding General Courses

37. If the course does not exist, create a new one. In Create Courses & Content, select General Course and Go.

38. On the Create New General Course screen, add the course title, description and keywords. See the Naming Conventions section for specific information.

39. Under Document Type, select File, URL or Video.
   - If you choose File, browse for the file (such as a PDF, document, PowerPoint or Excel spreadsheet).
   - If you choose URL, paste the course URL in the Enter URL field.
   - If you choose Video, enter the Video URL or embed code for the video and click the Test Video button.

40. Click Create.

41. On the main course screen, scroll down to course attributes.
   - If the course has Prerequisites, click Edit and add them.
   - If this course replaces a previous version or has another Equivalency, click Edit and add it.

42. By Content Sharing, click Edit.
43. On the Manage Content Sharing screen, make sure the Shared boxes are checked next to:

- Human Services, Department of
- Oregon Health Authority
- Other, Non State Employees

Note that the box will already be selected for your domain, which is called the Owner Domain.

44. Scroll to the bottom of the screen and click Save.

45. Back on the main course screen, by Permissions, click Edit.

46. On the Edit Permissions page, click Assign Permissions.

47. Fill out the fields as follows:

- Search for: “human services,” “health authority” or “other, non state”.
- Search Type: All words
- Type: Organization
- User Search: All Domains

Click the Search button.
Adding General Courses

48. Find the organization and check the box in the View column. Click Save.
   - Repeat this for all the domains you shared content with.

49. On the Edit Permissions page, make sure all the permissions are in place. To do this, change User Search to All Domains and click Filter. This will display a list of all permissions.

When you’re finished, click Save, then click Back.

50. When you’re finished, scroll to the top of the main course page. Click the Check-in button.
Updating Courses

In iLearnOregon, you can update existing SCORM courses as long as the changes are minor, such as changes to text on existing slides.

NOTES:

• This will NOT work if you make structural changes, such as adding or deleting slides or quiz questions. As a result, students who have started (but not completed) the course will have to start over. Instead, add a structurally-changed course as a new course.

• While iLearnOregon includes a Versioning option for updating courses, it doesn’t work well at this time and is not recommended. See the section, Versioning.

• If an eLearning course is updated, this will automatically change any curriculum that includes the course and students who completed the curriculum will now show as incomplete. See the section, Curriculums.

Steps:

1. As with new courses, you should upload the revised course in the iLearn Test site first to ensure it works properly: ilearn-testing.oregon.gov

2. In iLearn, click the Responsibilities Tab. Under Manage Content, select Search & Create Content.

3. Search for the course and click on the title.

4. On the main course screen, click Checkout.

5. Next to Course Files, click Edit.
6. On the **Upload Course Files** screen, click **Browse** and select the updated **zipped** course file. When you’re finished, click **Upload**.

   **NOTE:** The zipped course file should be located on your desktop, *not* a network drive.

![Upload Course Files](image)

7. After the file finishes uploading, click **Back**.

8. Change any other course settings, if needed. **NOTE:** Do not use the **Versioning** option. It can create problems and is not reversible.

9. When you’re finished, select the **Check-in** tab so users can access the course.
Changing Course Availability

There are two ways to make a course unavailable for registration.

- While you’re editing the course, it will be Checked Out. While unavailable for registration, it will still appear in search results.
- Make the course Inactive, which will hide it from the search results. For more information about managing activity, see the iLearnOregon Course Administrator’s Manual.

To make a course unavailable for registration

1. Click the Responsibilities Tab. Under Manage Content, select Search & Create Content.

2. Search for the course and click the course title.

3. On the main course screen, click Checkout.

4. Scroll down to Manage Activity and click Edit.

5. Change the course setting to Inactive. If needed, you can set Start and End dates for when the course will remain either Inactive or Active. Click Save.

6. When you’re finished, click Check-in.
To make a course available for registration

Check out the course and change the **Manage Activity** setting back to **Active**.

Select **Check-in** when you’re ready to make the course available for registration again.
Who Can Manage & Take Courses?

**NOTE:** Be sure the Content Sharing and Permissions options are set for everyone who needs to take the course. Often, this means sharing content with “Other, Non State Employees” or adding permissions at the Organization level. See the Content Sharing and Permissions information under Adding SCORM Courses or Adding General Courses.

You’ll receive Manage permission for each course you own. Managing permission at the course level enables you to specify who can take the course and add other course managers.

7. Click the Responsibilities Tab. Under Manage Content, select Search & Create Content.

8. Search for the course and click the course title.

9. On the main course screen, click Checkout.

10. By Permissions, click Edit.

11. On the Edit Permissions page, click Assign Permissions.
12. Search for the person you want to add.

- **Search for:** Add the name, both last and first
- **Search Type:** All words
- **Type:** User
- **User Search:** All Domains

When you’re finished, click **Search**.

13. Next to the person’s name, check **View** and, if appropriate, **Manage**.

When you’re finished, click **Save**.

14. If the name doesn’t appear on the **Edit Permissions** screen, change the **User Search** field to **All Domains** and click **Filter**.
Section 3:

Managing Enrollment

This Section includes

- Viewing Course Participation
- Enrolling Users in an Online Course

For advanced information, look for the Power User icon.
Viewing Course Participation

To see a list of students who have started or completed an online course:

1. Click on the **System Tools** icon.

2. In the **System Options** pop-up window, select **System**. Click **Reporting** and **Reports Console**.

3. On the **Reports Console** screen, search for **training progress by content**. (You can also leave the **Search Text** field blank and simply click the **Search** button for a list.)

   Changing the **Search Type** to **All words** or **Exact phrase** will narrow search results. Then click the report, **Training Progress by Content**.
4. Click the Select button.

5. Enter a search term, like the name of the course. If you know the exact name of the course, reduce the search results by selecting Exact phrase from the Search Type dropdown menu. Check the Online box and click Search.

6. Choose your course and click Select.

7. To get all active user results: On the Run Report screen, check the box next to Include all sub-organizations. Do not select any organizations.

   To get user results only from a specific organization: Click the plus sign next to the type of Organization to expand options. For example, the plus sign next to State of Oregon will open a list of agencies and organizations within the state. NOTE: Do not check the box by State of Oregon unless you want to include all state agencies and organizations.
Viewing Course Participation

Make your selection from the list: for example, Human Services, Department of and Oregon Health Authority. Check Include all sub-organizations to include all the additional groups listed under the agencies and organizations you selected.

8. Scroll down to the bottom of the screen. Set User Activity to Active. Leave the Progress Status field blank to include users who have started, enrolled in, and completed the course. Click the Run Report button.

9. A new window will open. Depending on the size of the report, it can take a minute or two to open. NOTE: Be sure your browser is not blocking pop-up windows.

To sort the results:

A. Click on the column headings to sort the results by name, date, score, etc. or click the Sort button for more specific sorting.

B. Click Filter to narrow your search. For example, to see who completed the course: Progress status=Complete.

10. When you’re finished, you can get a copy of the report by selecting Export to Excel, PDF or XML.
Enrolling Users in an Online Course

1. From the Home screen, click **Responsibilities** and go to the **Manage Content** section on the right side of the page. Select **Management Enrollment for Online Courses**.

2. Search for the course and select it.

3. Select **Enroll Users** by the course name.

4. This opens a **Batch Enroll** screen, where you can search for users and add them to the course.

The course title and link will appear on the user’s home page.
Section 4:

Appendix

This Section includes

- Naming Conventions
- Curriculums
- Versioning
- Creating Deeplinks to Online Courses
- How to Reduce Online Course Size
- Reports
- Uploading Captivate (v7+) Courses to the LMS
- Powtoon Videos: How to Add

For advanced information, look for the Power User icon.
Naming Conventions

Online courses follow the same naming conventions as the other course types. They are easily identified by a computer icon and by Type: Online.

Course Title
First, ensure your course does not already exist in the Learning Catalog. If it does, make the old version unavailable for registration. (See section, Changing Course Availability.)

Include a space before and after each hyphen.

- Start with the 3 letter organization code: DHS or OHA, or DHSOHA (as shown above) for Shared Services.
- Follow it with a space, a hyphen and a space.
- Add your division, area or office code: for example, DMAP, SSP or OIS.
- Follow it with a space, a hyphen and a space.
- Add the course name: for example, DHS – OCP – Contracts Overview.
- Finally, if the course was previously in the Learning Center, follow the course title with a space, a hyphen and a space, then include the course number, as shown above.

Character limit: Must not exceed 100 characters (including spaces and punctuation).

NOTE: Out-of-date online courses that have been made inactive should include “Retired Course:” before the course title. For example:

DHSOHA - OED - Retired Course: Feedback for Managers – C01111

Course Description
The course description is included in the email sent to the learner from iLearnOregon. It should be concise. NOTE: While iLearnOregon allows unlimited characters in this field, it does not format, which makes the text difficult to read.
Curriculums

If an eLearning course is updated, it will automatically change any curriculum that includes the course. Let all instructors know that you’ve updated the course so they can change their curriculums, too.

A curriculum is a collection of courses and materials about a specific topic.

• For information on how to create, change or hide a curriculum, see iLearnOregon Course Administrator’s Manual > Curriculums section.
• Curriculums can include classroom, virtual and online courses, as well as materials like PDFs, PowerPoints and more. For information on how to upload these materials, see the iLearnOregon Course Administrator’s Manual > Documents & Resources section.
• If courses need to be taken in sequence, you can organize them in a curriculum so that they must be taken in the order you choose (for example, a new employee curriculum).

NOTE: Courses will still be available as individual courses outside the curriculum.

If you need to change an existing curriculum, users who already finished the curriculum will now show it as being incomplete. To keep that from happening, follow the steps in the section, iLearnOregon Course Administrator’s Manual > Curriculums.
Versioning

Versioning was designed to keep track of each new version of a course you uploaded. While this would simplify reporting, unfortunately, it can cause issues with your course. Do **NOT** use Versioning at this time.

What happens?

- New students may have problems finding the latest version of the course. Returning students may have to re-take the course when the version they started, but didn’t complete, is no longer available.

- Versioned courses “break” curriculums for students who completed previous versions. This means the course will show as Started, instead of Complete, on their transcripts.

What to do

It depends on the type of changes you made to your course.

- If you made **simple changes** (like text changes) to existing slides, you can upload a revised course over an existing one. See Updating Courses.

- If you made **structural changes to the course**, such as adding or deleting slides or quiz questions, add it as a new course and hide the existing one.

- Consider adding a version number at the end of the course title. For all prior inactive versions, add “Retired Course:” before the course title, like this example.  
  **DHSOHA - OED - Retired Course: Feedback for Managers – C01111**

  **NOTE:** Like versioned courses, new online courses will automatically change any curriculum that includes the course. Let all instructors know that you’ve updated the course so they can change their curriculums, too. See Curriculums.

- For reporting purposes, manually keep track of all versions of a course. When Versioning becomes functional, we’ll let you know.
Creating Deeplinks to Online Courses

“Deeplinks” are links you can include in communications (like emails and documents) that lead directly to a classroom, virtual or online course. These instructions show how to create a shortened deeplink to your online course.

.NOTE: If you include more than one deeplink in a document (such as a training calendar), each link will open a separate new browser tab. Before starting each new course on the list, users should close the browser tabs for courses they’ve taken.

1. Make sure you’re in Learning > Home (your student view) and search for the course in the Search Catalog field.

2. Once you’ve opened the course, click on Item Details on the main course page.

3. A box will open up on your screen and the background will grey out. Highlight the Content Link. This is what you will paste into go.usa.gov.

.NOTE: “Go.USA.gov” is a URL shortener that lets government employees create short .gov URLs from official government domains, such as .gov, edu, .fed.us, or .state.xx.us URLs. You can create a free account using your state.or.us e-mail address.
Creating Deeplinks to Online Courses

• **NOTE:** You can also paste this link into an Outlook email message and change the link to the course title. To do this, paste the link into an email, highlight the link, right-click and select **Hyperlink**.

  ![Hyperlink Image]

• Change the **Text to display** field to the course name. Make sure the hyperlink appears in the **Address** field. The **Existing File or Web Page** button at the left should also be selected.

  ![Existing File or Web Page Image]

The course name will now display in your email. Be sure to test the link before sending the email.

  ![Click here to take the course Image]

4. Login to your “go.usa.gov” account, or create an account if you don’t have one. Once you’re logged in, paste the link you just copied and click the **Shorten** button.

  ![Create short, trustworthy .gov URLs Image]

5. Your Shortened URL will appear. This is the link you’ll send in communications about your course.

  ![Shortened URL Image]
Creating Deeplinks to Online Courses

6. Back in iLearn, click **Responsibilities** (your administrator view). Under **Manage Content**, click **Search & Create Content**.

7. Search for the course and click the course title.

8. On the main course page, click **Checkout**.

9. By **Summary**, click **Edit**.

10. Paste the go.us.gov **Shortened URL** at the end of the **Course Description**. Label it as “**Course link:**” as shown.

   When you’re finished, click **Save**.

   **NOTE:** Do **not** put the deeplink (or other information) into the **Course Number** field, which is located in the **Course Information** area. It can cause errors when running reports on the course.

11. Click the **Check-in** tab.
How to reduce online course size

Although iLearnOregon has a maximum file size of 300MB for eLearning courses, it’s **strongly** recommended that you keep the size of your zipped course file at 40MB – 60MB. **Why?** Users may not be able to download larger courses, which means many people won’t be able to take your course. You may have problems uploading the course, too.

What are the best ways to reduce file size?

1. If your course includes narration, **reduce audio file size**. In Adobe Captivate, the default setting for audio is 96kbps (near CD bitrate quality). Setting it to 64kbps (FM bitrate quality) will reduce the file size substantially. To do this:
   - In Captivate, go to Edit > Preferences > Recording > Settings. Click the **Audio Settings** button, then change the setting to FM Bitrate (64kbps).

2. If your course includes embedded video, remove it and **stream the video** instead. To get your video uploaded to YouTube, contact the OIS Web Team.

3. **Reduce the size of image files**. If you don’t have Photoshop or another image editing program, you can do this in PowerPoint. Here’s how:
   - Insert the image in PowerPoint.
   - Change the largest dimension (width or height) to 3".
   - Right-click on the image, then "Save as picture."

   If you’re using Photoshop, this will be a two-step process:
   - Resize the images. Typically, you can set the largest dimension to 500 pixels.
   - Optimize the images in Photoshop by clicking CTRL + Alt + Shift + S. Optimizing will significantly reduce the size of image files.
   - If you re-sized images in PowerPoint, you can optimize them even more in Photoshop by experimenting with file type options.
How to reduce online course size

4. Remove unused items from the Library in Captivate. To do this, click the Library icon (next to Properties), then click the Select Unused Items icon. This will highlight all images that were imported, but not used.

Next, click the Delete (trash can) icon, located next to the Select Unused Items icon.

5. Minimize or eliminate transition effects used.

6. If you have a slide that pauses, ensure that it isn’t longer than necessary on the timeline. Typically, you can trim slides down to about 3 seconds.

7. Use solid colors instead of gradients.

8. In Captivate, avoid using FMR (Full Motion Recording) if possible. (FMR slides have a Video Camcorder icon at the bottom right-hand corner of the slide.) To prevent FMR slides from being included in the published file, you can either:
   - Hide each slide (select the slide, right-click and choose Hide Slide), or
   - Use the Library panel to delete the slides.

9. Other options in Captivate:
   - Make the slide dimensions (resolution) smaller. Go to Modify > Rescale Project. You may have to reposition text and graphics on some slides.
   - Change the quality and compression settings for images. Go to Edit > Preferences > Project > Size and Quality. Uncheck Retain Slide Quality settings to reduce BMP quality, or reduce the percentage quality of JPGs.


There are many more resources and ideas in eLearning forums and blogs. Let us know what you learn! Share your best tips so we can strengthen our eLearning community.
Reports

When using iLearn’s Reports feature to pull a report for eLearning course completion, pull two reports: one on the General Course version (for any versions migrated from the Learning Center) and one from the SCORM course created in iLearn.

If the course was ever updated, you may have more than one SCORM version in iLearn. This will require pulling additional reports.

For more information on reports, see the Built-in Reports Guide.

Uploading Captivate (v7+) Courses to the LMS

First, make note of the course dimensions (width and height). If your course has a Table of Contents (TOC) that isn’t collapsible, add enough pixels to accommodate it. For example, for a Captivate course with a side TOC, add 250 pixels to the width.

Prepare your course in Captivate

In Captivate, go to File menu > Publish. On the Publish screen, choose settings:

- **Project title (the filename):** Make it fewer than 15 characters, lowercase, no special characters or spaces.
- **Advanced Options:** Choose *Scalable HTML*
- **Folder:** Export files locally to your desktop, not to a network (save backups on the network).
- **Output Format Options:** Choose *SWF, HTML 5*
- **Output Options:** Choose Zip Files, Export PDF (if needed), Flash Player version: Flash Player 10
- Click on the Preferences button on the right/middle.
  - **Recording:** Click the Audio Settings button. Select FM Bitrate (64kbps) to reduce file size.
Uploading Captivate (v7+) Courses to the LMS

- Under Quiz > Reporting:
  - At top, check **Enable reporting for this project** (even if you don’t have a quiz). If you choose **Slide Views**, do **not** choose 100% or users won’t be able to finish. At most, choose 90%.
  - Select **LMS: Other Standard LMSs** and **Standard: SCORM 1.2**. Click on the **Configure** button.
    - In the **Title** field, enter the course title. Your title will replace “Captivate E-Learning Course.” Keep the title short and don’t add any characters except a hyphen (-) or underscore (_). If the title is too long or includes other characters, the course may not upload.
    - Click **OK** button.

- **Quiz > Settings**: Do **not** select **Shuffle Answers**. Be sure that **Allow Backward Movement** is **not** checked, as this causes errors.

- **Quiz > Pass or Fail**: Under **If Failing Grade**, don’t select **Infinite Attempts**. (This can frustrate users for quizzes like multiple answer.) Instead, choose a reasonable number of attempts, such as 3.

  - Click the **OK** button to close this menu.

- Click on the Publish button.

---

Upload the course to the LMS Test site

- Login to the Learning Management System (LMS) TEST site.

- See instructions for your LMS on how to upload the course.

- Keywords: Be sure to include common terms that learners would use, even misspellings.
Uploading Captivate (v7+) Courses to the LMS

• Synopsis: Keep this brief, a few sentences. **NOTE: Each office must provide an alternate format if requested by a student.** Be sure to add the following phrase with your office name and contact info: “If you use assistive technology and need an alternate format, please contact:____”

---

**Test Your Course**

Testing is the most important step prior to making your course live. Have your Subject Matter Experts (SMEs) verify that the content of the module is accurate. It is important to have people who are not familiar with the course do testing as well to help ensure your learning goals are met.

In the Learning Management System TEST environment, search for your course using a keyword. Be sure you’re checking for Active courses.

An overview of some of the elements to consider when testing:

- Start the course but don’t complete it. Is it listed under ‘Online courses’ on your homepage?
- Complete the course. Is it ‘complete’ on your transcript and removed from your homepage?
- Does every button work? Do all of the Next and Back buttons work?
- Is the content cut off by the window size? Did you publish as scalable HTML?
- Does the audio work correctly? Is the audio file size set at FM Bitrate (64kbps)?
- Does the closed captioning work correctly?
- Is everything spelled correctly?
- Do all URL links and other links in the module work?
- Did you test in different operating systems and browsers? Try it on a home computer? Have you had several people test in the TEST environment? (Ideally include SMEs and people not familiar with the course.)
- If you have video, does it play correctly and in its entirety?
- Is your module ADA compliant? Research accessibility for specific compliance instructions.
- Do page transitions advance correctly (giving the viewer time to read content, for example)?
Uploading Captivate (v7+) Courses to the LMS

If you need to troubleshoot in Captivate and upload a corrected version, repeat all of the steps in Uploading Captivate (v7+) Courses to the LMS: Prepare your course in Captivate. If you upload several versions, be sure to inactivate previous versions. When you are done testing your course, upload to Production (a.k.a. the ‘live site’). Finally, be sure to test your course in Production to verify that the course functions properly.

Powtoon Videos: How to add

PowToon videos are added to iLearn as General Courses linked to the video URL. Unfortunately, the Powtoon website makes users think they need to register with Powtoon to view the video. The website also enables users to read and submit any comments they want under the video.

Here’s an example of the Powtoon website shown below:
https://www.powtoon.com/online-presentation/dGRWgM1VEfv/employment-1st/?mode=movie

Notice the “Sign up for free” button, Login and Sign up buttons on the top right, and the Sign up For Free picture ad.

Also notice the Facebook Comment Box under the video.
Powtoon Videos: How to add

To get rid of this view and link to the video only:

15. Under the picture ad, click the “embed” icon.

16. In the pop-up window, copy the highlighted portion of the URL (without the quotes “”), as shown.

This is what you will need to use when you are creating the General Course and using a video from a website.

NOTE: Be sure to copy only the URL, not the entire code.

17. In iLearn, click the Responsibilities Tab. In the Administration Console Training section, click General Course.

18. Under Manage Content, select Search & Create Content.

19. In Create Courses & Content, select General Course and Go.
20. On the **Create New General Course** page, fill out the required fields (marked with *).

21. Under the **Select File** field, click the round button next to **URL**.

22. In the **Enter URL** field, paste the embed code. Click **Create**.

Test the new course to make sure you no longer see the site in its entirety, but only the video.